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Welcome to 2015 Knowledge-Based Nontraditional Engagements for ProSystem fx® Knowledge Coach
This Release Notes document provides important information about the 2015 release of Knowledge Based Nontraditional
Engagements. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998,
option 4, then option 1. Additional information is available on CCH Support Online.

New in this Release
Knowledge-Based Nontraditional Engagements is designed to help the practitioner efficiently and effectively perform nontraditional
engagements in accordance with applicable standards issued by the American Institute of Certified Public Accountants (AICPA). The
knowledge-based methodology for nontraditional engagements is a risk-based methodology for conducting nontraditional
engagements. It emphasizes using knowledge of the entity, subject matter, and suitable criteria to perform procedures and, when
applicable, make risk assessments and recommendations in connection with an engagement.
Nontraditional engagements are often unique and complex, and require specialized accounting, attestation, and consulting knowledge.
Conducting nontraditional engagements requires the exercise of the practitioner’s professional judgment. This edition includes specific
up-to-date guidance for nontraditional engagements and is published for the purpose of communicating, to users of the toolset,
updates and enhancements included in the current version. This document is not, and should not be used as an engagement program to
update the documentation of an engagement started in a previous version of this product.
The methodology is presented in terms of its application for attestation and consulting-based engagements including:
•Examination-Level Attestation Engagements;
•Review-Level Attestation Engagements;
•Agreed-Upon Procedures Engagements (General);
•Examination-Level Engagements on Prospective Financial Statements;
•Compilation Engagements on Prospective Financial Statements;
•Agreed-Upon Procedures Engagements on Prospective Financial Statements;
•Examination-Level Engagements on Pro Forma Financial Information;
•Review-Level Engagements on Pro Forma Financial Information;
•Engagements to Report on the Effectiveness of an Entity’s Internal Control over Financial Reporting or Management’s Written
Assertion (Integrated with an Audit of Financial Statements);
•Examination-Level Engagements on an Entity’s Compliance with Specified Requirements or the Responsible Party’s Written
Assertion;
•Agreed-Upon Procedures Engagements on an Entity’s Compliance with Specified Requirements or the Responsible Party’s
Written Assertion;
•Examination-Level Engagements on Management’s Discussion and Analysis;
•Review-Level Engagements on Management’s Discussion and Analysis;
•Engagements to Report on Controls at a Service Organization (SOC 1);
•Engagement to Report on Controls at a Service Organization Relevant to Security, Availability, Processing Integrity,
Confidentiality, and Privacy (SOC 2);
•Due Diligence Engagements: Buyer’s Assistance;
•Due Diligence Engagements: Seller’s Assistance;
•Risk Assessment Engagements; and
•PrimePlus Services Engagements.

The methodology emphasizes the processes through which information or knowledge flows through the engagement process. The tools
in this edition have been developed in accordance with authoritative guidance including the Statements on Standards for Attestation
Engagements (SSAEs), Statements on Standards for Consulting Services (SSCSs), and related AICPA standards and requirements.
This document is published for the purpose of communicating the updates and enhancements included in the current version to users
of the toolset. This document is not, and should not be used as an attestation program to update the attestation documentation of an
engagement started in a previous version of this product.
This is the fourth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.
The 2015 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
The 2015 edition of Knowledge-Based Nontraditional Engagements features numerous enhancements, including:

 All SOC 2 reports have been modified to include the addition of the description criteria in the scope paragraph and includes
language that the AICPA SOC 2 guide may be used based on the auditor' judgment.

 Updated text and column header in KBA-103 to clarify the decision making process.
 Added a “Not Applicable” option in the “Functioning” column in the summary tables in ATT-401 and ATT-401N. Flow to KBA103 still only occurs on a “No” answer.

 New workpapers are available in this title:
o

AID-603 Understanding and Preliminary Assessment of the Entity's Internal Audit Function

o
o

RPT-0920 Attest Engagement: Unmodified Opinion on Management’s Assertion on Privacy Principle
RPT-0921 Attest Engagement: Unmodified Opinion on Privacy Subject Matter—No Written Assertion

o
o

RPT-0922 Attest Engagement: Illustrative Management’s Assertion on Privacy Principle
RPT-0923 Attest Engagement: Unmodified Opinion on ALTA Best Practices Assertion

o
o

RPT-0924 Attest Engagement: Unmodified Opinion on ALTA Best Practices-Criteria Attached (General Use)
RPT-0925 Attest Engagement: Illustrative Management’s Assertion on ALTA Best Practices

o RPT-0926 Attest Engagement: Unmodified Review Report on ALTA Best Practices Assertion (General Assertion)
For more information on specific program enhancements, review the 2015 Nontraditional Engagements Overview for Knowledge Coach
Users available at the following link or in the binder through the KCO-001 workpaper.
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20Nontraditional%20Engagements%20Title%20Overview%
20for%20Knowledge%20Coach%20Users.pdf
Note: There are 5 separate content packages for the Knowledge-Based Nontraditional Engagements title. The five packages are listed
below. All of on these packages only require one license to be assigned to the user in the Admin Module. Please see the section
Installation Instructions below for more information.







Knowledge-Based Nontraditional Engagements – Examinations
Knowledge-Based Nontraditional Engagements – Reviews
Knowledge-Based Nontraditional Engagements – Compilations
Knowledge-Based Nontraditional Engagements - Agree-Upon Procedures
Knowledge-Based Nontraditional Engagements – Consulting

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:
New literature, standards, and developments, reflected in the following current audit and accounting guidance:
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 AICPA Guide, Reporting on Controls at a Service Organization Relevant to User Entities’ Internal Control over Financial
Reporting (SOC 1)

 AICPA Guide Reporting on Controls at a Service Organization Relevant to Security, Availability, Processing Integrity,
Confidentiality, or Privacy (SOC 2)






AICPA Guide, Prospective Financial Information






TSP Section 100, including pending update on generally accepted privacy principles (GAPP)

Government Auditing Standards (GAGAS), 2011 Revision
AICPA Statement on Quality Control Standards (SQCSs) No. 8, A Firm’s System of Quality Control (Redrafted)
AICPA Statement on Standards for Attestation Engagements (SSAE) No. 17, Reporting on Compiled Prospective Financial
Statements When the Practitioner’s Independence Is Impaired
Exposure Drafts (EDs) on clarified AT Sections
Attestation Interpretation (AT) Section 9201
TQ&A Section 9540

Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based Methodology for Nontraditional Engagements- Allows the results of one set of procedures to become the input for
the next. The key components of the KBA methodology include:

 An Overview that guides practitioners through the methodology;
 Knowledge-Based Attestation documents, integral to the risk assessment and overall attestation processes, which contain steps
and procedures required by professional standards;






Customizable Engagement Programs that take practitioners through related steps and procedures;
Practice Aids to help practitioners complete steps or processes outlined in the overall engagement programs;
Practitioner’s Reports that provide a variety of sample practitioner’s opinions on nontraditional engagements; and
Correspondence documents that provide sample engagement and representation letters to be used to comply with professional
standards, SSAE and SSCS requirements, and in many other common situations.

ProSystem fx® Knowledge Coach

 ProSystem fx® Knowledge Coach functionality allows practitioners to use the Knowledge-Based methodology more efficiently
by eliminating the need for duplicate entry of the same information, tailoring attestation documentation to each particular
engagement, and documenting the link between risks identified and procedures performed. ATT-100 Tailoring Question
Workpaper or CON-100 Tailoring Question Workpaper is a document in Knowledge Coach that presents engagement-level
questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the
practitioner avoid duplication and unnecessary workpapers.

 Before you begin your engagement, please review the guidance in ATT-101 through ATT-114 Overall Attestation Programs and
CON-101, CON-102, CON-104, and CON-106 Overall Engagement Programs. This workpaper is intended to be your road map
through a Knowledge-Based methodology. You should start your engagement with ATT-100 Tailoring Question Workpaper and
ATT-101 through ATT-114 Overall Attestations Programs or CON -100 Tailoring Question Workpaper and CON-101, CON-102,
CON-104, and CON-106 Overall Engagement Programs.

 Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file.

 Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.
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 Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes attestation content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA.
Also, if you subscribe to the Knowledge-Based Nontraditional Engagements Guide on ARM, you can take advantage of links to
the audit guide material from within the Knowledge Coach documents.

 Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help practitioners work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.
Important Notes

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
 If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o

Keep the binder with the affected workpapers open.

o

Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.
System Requirements

 This title MUST be used with ProSystem fx ® Engagement version 7.2, ProSystem fx® Knowledge Coach version 2.2, and 2015
Financial Statement Base v5 and higher. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please contact
Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions
Download the 2015 Knowledge Based Nontraditional Engagements from the ProSystem fx ®Knowledge Coach Updates section of the
ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select the
Knowledge Coach Series and Download file link next to the 2015 Knowledge-Based Nontraditional Engagements. On some occasions
the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.
Note: You must install the following before updating to the 2015 Knowledge-Based Nontraditional Engagements titles:

 CCH® ProSystem fx® Engagement 7.2 and Knowledge Coach 2.2
 2015 Financial Statement Base Title for the Examinations title
 2014 Financial Statement Base v5 for the remaining titles.
If you already have the 2014 Financial Base installed, apply the Knowledge Coach Content Update October 2015 to
receive the v5 updates
 CCH® ProSystem fx® Engagement 7.2 and Knowledge Coach 2.2 September Update
Knowledge Coach Content Update October 2015. The Financial Statement Base title is also available at the following link:
http://support.cch.com/updates/KnowledgeCoach
If you have already installed this title for 2015 Knowledge-Based Nontraditional Engagements, ensure you have the latest Knowledge
Coach Content Update installed.
Important: ProSystem fx® Engagement version 7.2 or higher and Knowledge Coach version 2.2 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).
o
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The 2015 Knowledge-Based Nontraditional Engagements (12/10/15). KCP download is a proprietary file that must be installed from
within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in the Release
Bulletin.

Installation Instructions
Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.
After downloading the 2015 Knowledge Based Nontraditional Engagements, do the following:

 Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

 The Knowledge Coach Titles window will be displayed.
 Choose Add Title.
 Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

 Choose Open.
 The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.
Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.
To unrelease a title:

 Select a version of the Knowledge-Based Nontraditional Engagements titles.
 Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.
Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.
To release a title:

 Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
 Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.
Important: Once the 2015 Knowledge-Based Nontraditional Engagements titles have been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key
Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.2 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2015
Knowledge-Based Nontraditional Engagements.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
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Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager
CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.
Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.
Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.
Also available in the Knowledge-Based Nontraditional Engagements title, a guide that helps you comply with the most recent
professional standards and guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools, and
other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are available
in Knowledge Coach.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.
Reference to Accounting Research Manager (ARM) – If you subscribe to an ARM library that includes nontraditional engagement
content, you can link directly to source material from Resources within Knowledge Coach documents. These links have been updated to
refer to the accounting standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based
Nontraditional Engagements Guide on ARM, you can take advantage of references to the guide material from within the Knowledge
Coach documents.
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Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper
Templates, open a binder in ProSystem fx®
Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select
New Knowledge Coach Workpaper from the toolbar
or File menu. The New Knowledge Coach Workpaper
dialog appears (Figure 1).
Select the New Knowledge Coach Title with the
content you would like to use. You can only select
titles you have installed. The information displayed
changes to reflect the workpaper organization
available for the selected title. Select the Knowledge
Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper
Properties dialog appears. Each workpaper name is
automatically loaded into the Name field. Add a
workpaper index in the Index field and make any
Name modifications you desire. You can also modify
the tab location or the roll forward settings for each
workpaper. Then click OK. The integrated Knowledge
Coach workpaper is now inserted into your
engagement binder. For more information on how to
use Knowledge Coach workpapers in your binder, see
the Knowledge Coach User Guide.

Figure 1 - New Knowledge Coach Workpaper
Download
Description:

2015 Knowledge-Based Nontraditional Engagements
(12/10/2015)

Version:

Engagement v. 7.2 with Knowledge Coach 2.2 or higher and
2015 Financial Statement Base v4

Release Date:

December 2015

File size:

18MB

Approx. Download
42 minutes at 56 kbps
Time:
License:

Full Version

Platforms:

Windows® 7, 8 and 8.1

Office:

Microsoft® Office 2007 required
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Contact Information

 For a demo or to purchase additional titles as they become available

1-800-PFX-9998, option 1

 Technical Support

1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.

8

